Instruction Guide
for using the
Bridge Asset Management Plan Template
Contents

Saving the template files on your computer ................................................................. 1

Entering data into the Excel data template ................................................................. 2
  Using the XLSM File for the First Time ........................................................................ 2
  Instructions Worksheet ............................................................................................... 2
  1-MiBRIDGEreport Worksheet ................................................................................... 3
  2-Questionnaire Worksheet ....................................................................................... 7
  3-MaintenancePlan and 4-InspectionFollowup Worksheets ........................................... 8
  5-ProgressTracking Worksheets ................................................................................. 10
  6-Table5 and 6-Table6 Worksheets ............................................................................. 11
  TOC Worksheet ....................................................................................................... 13

Build a Bridge Asset Management Plan ................................................................. 13

Using the Word template ............................................................................................ 23
  Opening the Word template ...................................................................................... 23
  Linking/re-linking the Excel spreadsheet data to the Word template ......................... 23

Inserting content into/ customizing the bridge asset management plan Word template ........................................................................................... 25
  Inserting a logo ........................................................................................................ 25
  Changing the color bar (Optional) ........................................................................... 27
  Changing color of Cover and Heading 1 Styles (optional) ........................................ 28
  Inserting charts (manual procedure) .................................................................... 30
  Inserting images .................................................................................................... 31

Creating a map of bridge assets in Roadsoft ............................................................ 33

Completing the Word template .................................................................................. 36
  Working with list items ............................................................................................ 36
  Working with red text fields ................................................................................. 37

Generating annual cost projection/gap analysis data from the budget template .......... 39
  Welcome Worksheet ............................................................................................... 39
  Summary Worksheet .............................................................................................. 43
  Adding Bridge Cost Estimates .............................................................................. 44
  Creating a Cost Projection/Gap Analysis Table .................................................... 51
  Creating Financial Resources Content ................................................................... 55

  Developing Financial Resources Content in the Bridge AMP Data Workbook ........ 55
  Developing Financial Resources Content in the Bridge AMP Data Workbook .......... 56

Reviewing the template for errors and finalizing ....................................................... 58

Updating Table of Contents, Table of Figures, and/or Table of Tables ...................... 59

Inserting Appendixes ............................................................................................... 64

APPENDIX .............................................................................................................. 66

Alternate Directions for: 2-MiBRIDGEreport Worksheet ............................................ 66

© 2019 Center for Technology & Training. All rights reserved.
Prepared on behalf of the Michigan Transportation Asset Management Council.
Second Printing
This document provides instruction for creating a personalized asset management plan for your specific agency by using the files BridgeAMP.docx, BridgeAMP-Data.xlsm, BridgeAM-Budget.xlsm, [Your County].csv, and [Your CSV].csv, distributed to you by the Center for Technology & Training in collaboration with the Transportation Asset Management Council and the Michigan Department of Transportation. Bridge asset data for your agency will need to be entered into the Microsoft Excel spreadsheet. This spreadsheet will parse the data for the Microsoft Word template, which will have the Excel data linked to it. This Instruction Guide will detail how to enter data into Excel and, subsequently, complete the text fields in Word.

Saving the template files on your computer
The four template files for creating a bridge asset management plan will be provided to you on a USB drive. **Do not rename these files at any time while working with them.** These files should be stored on your PC in a location that is easy to find and access, but the files themselves should *not* be renamed. It is recommended that a new subfolder be created in your Documents or My Documents folder or a new folder be created on your desktop. This new (sub)folder should be given a unique name, such as “BridgeAMP-2020”. The .docx, .xlsm, and .csv files should be saved in that new (sub)folder. It is also recommended that any other content needed for your bridge asset management plan—such as logos and images—be kept in this folder, as well.
Entering data into the Excel data template
The Excel template allows you to enter your agency’s bridge data, which will subsequently populate the Word template that you will personalize for your agency’s bridge asset management plan. This Excel template runs calculations in the background so that the data you enter will be parsed into the appropriate formats for the bridge asset management plan.

**NOTE:** Several of the worksheets in the BridgeAMP-Data.xlsm workbook are protected to prevent inadvertent changes. A number of those protected sheets require a password to unprotect the sheet. If a password is password protected and you wish to modify protected cells, the password is “password”.

Using the XLSM File for the First Time
You will see a security warning when you open a macro-enabled Microsoft Office file for the first time. If this file is from a trusted source, select **Enable Content**.

**NOTE:** You must enable macros for this workbook to function.

Instructions Worksheet
**NOTE:** When you open the BridgeAMP-Data.xlsm file, you will be greeted with a welcome message in the Instructions worksheet.
1. Select Let’s Get Started.

1-MiBRIDGEreport Worksheet

**NOTE:** The *1-MiBRIDGEreport* worksheet requires a customized MiBRIDGE dataset; this dataset will be provided to you during the workshop on the USB drive. By selecting Let’s Get Started on the Instructions worksheet, you will be guided through the importing of your data. If this process fails, you may unhide the *1-MiBRIDGEreport* worksheet, unprotect the worksheet, copy the data in your [Your County].csv file, and paste it in the appropriate columns in the *1-MiBRIDGEreport* worksheet. The steps for manually importing your data are detailed in a note after Step 3.

⇒ A message box opens when you automatically progress to the *1-MiBRIDGEreport* worksheet (see figure below).

1. Select OK in the message box.

⇒ The Please select your custom MiBridge data file dialogue box opens.
2. Navigate to and select the [your county].csv data file that you received with your bridge asset management plan template files in the dialogue box, and select Open.

Excel will automatically import your MiBRIDGE data. It may take a few minutes to process all the data.

3. Review the imported data, select Save in order to save your work before continuing, and select Done (see figures below).

**NOTE:** It is recommended that you save your work before selecting Done since the MiBRIDGE import takes a while. If you encounter any errors in using the Excel workbook, you can resume your work from this save point (see figure below).

**NOTE:** If you need to edit any of the imported MiBRIDGE data, select Edit Data. Then select Done.
NOTE: If necessary, you can manually import the data using the following steps:

a. Open the [Your County].csv file.

b. Copy data in the [Your County].csv file.

   i. Highlight the cells from the first column, first row of data—excluding “owner” data—and excluding the headings—through the last column, last row of data.

   NOTE: The data most likely begin in cell B2. It will end in column AU; the last row depends upon the number of bridges in your agency’s inventory.
c. Copy data from [Your County].csv’s local data extract worksheet:
   In the *Home* ribbon, select **Copy** from the *Clipboard* group.
   OR: Right-click on the highlighted cells; select **Copy** from the dropdown menu.
   OR: Use the **Ctrl + C** keyboard shortcut.

d. Return to or open the BridgeAMP-Data.xlsm file.

e. Select the **1-MiBRIDGEreport** tab to access the **1-MiBRIDGEreport** worksheet (see figure below).

   ![Image of 1-MiBRIDGEreport tab]

f. Set cursor in cell C2 (see figure below).

   ![Image of cell C2]

g. Paste data into the **1-MiBRIDGEreport** worksheet:
   In the *Home* ribbon, select **Paste** from the *Clipboard* group.
   OR: Right-click in cell C2; select **Paste** from the dropdown menu.
   OR: Use the **Ctrl + V** keyboard shortcut.
   **NOTE:** Microsoft Excel will take a while to process all of the formulas that depend on the data that you just pasted into the Excel workbook.
h. Remember to select **Save** in order to save your work before continuing.

2-**Questionnaire Worksheet**

**NOTE:** The 2-**Questionnaire** worksheet requires your response to several questions that will help tailor your asset management plan content. By selecting **Done** on the 1-MiBRIDGEreport worksheet, you will automatically progress to the questionnaire. If this process fails at any point, you may visit the **TOC** worksheet and unhide the 2-**Questionnaire** worksheet (see figure below).

**NOTE:** The 2-**Questionnaire** worksheet and several of the following worksheets are protected in order to provide guidance in modifying only the necessary cells. Throughout the Excel template, heading rows should not be altered; altering heading rows will prevent data from transferring into the Word template.

1. Answer the questions on the questionnaire (see figure below).

**NOTE:** You are only able to type in green or red cells in Column C. Column B (white cells) contains the questions, Column D (white cells) contains answer prompts and/or examples to make sure you format responses correctly, and Column F (white cells) contains preview text that will update to illustrate how the answer will be reflected within the context of the asset management plan (see figure below).
NOTE: Some green cells are dropdown lists. If none of the listed answers appropriately reflects your agency’s situation, select the blank entry in the dropdown list, and then type your answer into the green cell; note that in some cases this is discouraged.

2. Review your responses, select Save in order to save your work before continuing, and select Done (see figures below).

![Figure 1](image1.png)

![Figure 2](image2.png)

⇒ You will be directed to the 3-MaintenancePlan and 4-InspectionFollowup worksheets.

3-MaintenancePlan and 4-InspectionFollowup Worksheets

1. Begin indicating your agency’s plan for maintenance and inspection follow-up by inserting a lowercase “x” (alternatively, you may choose to use “h”, “m”, “l” for high, medium, and low priority items to correspond with your agency’s prioritization metric, which can be optionally indicated in the BridgeAM-Budget.xlsm workbook) in its corresponding replacement, rehabilitation, proposed preventive maintenance, and/or proposed scheduled maintenance item—in 3-MaintenancePlan’s columns E through AQ—and in its corresponding inspection follow-up item—in 4-InspectionFollowup’s columns E through M (see figure below).

NOTE: You can toggle between the 3-MaintenancePlan and 4-InspectionFollowup worksheets using the Go to… button or the worksheet tabs, indicated by the green arrows in the figure below.
2. Review your responses, select **Save** in order to save your work before continuing, and select **Done** (see figures below).

⇒ You will be directed to the **5-ProgressTracking** sheet.
5-ProgressTracking Worksheets

1. Select OK in the message box after reading the information.

2. Fill in the green fields of the chart with bridge condition goals and your historic (Columns D and E), current (Column F), and projected bridge condition (Columns G through K) information. The graph to the right of the table will update automatically as data is entered into the chart.

**NOTE:** The Goal/Fair Goal (J3), the Structurally Deficient Goal (J4), and the year (F8) data come from your answers to the goals section of the 2-Questionnaire worksheet (cells B13, B14, and B23, respectively). If you wish to change these goals or the years reflected in the graph, you will need to make the change on the 2-Questionnaire worksheet.
3. Review your responses and the graphs, and select **Done**.

![Graph](image_url)

- A message box will appear to notify you that you are proceeding to the next step of the creating tables for scour critical bridges and posted/closed bridges. You will then automatically proceed to the **6-Table4** worksheet.

### 6-Table5 and 6-Table6 Worksheets

**NOTE**: Table 5 in the bridge asset management plan identifies scour critical bridges. This data will be pulled from your MiBRIDGE data, so you will automatically proceed past Table 5 to Table 6, which lists posted/closed bridges in your jurisdiction and requires you to identify them as critical links.

1. Select **Yes** or **No** in the message box depending upon whether the specified bridge is a critical link (see figure below).
All the critical links will be displayed in *Posted/Closed Bridges that are Critical Links*.

2. **OPTIONAL:** Add comments about the critical-link posted/closed bridges in the 6-Table6 worksheet Column D.

3. Review both 6-Table5 and 6Table6 worksheets, using the tabs to toggle between them (see figure below).

4. Select Save in order to save your work before continuing, and select Done (see figure below).
TOC Worksheet

NOTE: The TOC worksheet serves as an access point to the various worksheets in your workbook, and becomes available for viewing once finished with the Instructions worksheet. The TOC worksheet also serves as the location from which you can build your Compliance and/or your Bridge Asset Management Plan (see figure below).

Build a Bridge Asset Management Plan

1. Select Build Bridge Asset Management Plan on the TOC worksheet.

⇒ The Please select your bridge asset management plan window will open.

2. Select your bridge asset management plan .docx file in the Please select your bridge asset management plan window.
3. Select Open.

After selecting the Word template, the four buttons underneath the **Build a Bridge Asset Management Plan** button will become active.

4. Select **BAMP Step 1: Export PT Graph & Tables**.

A message box will open.
a. Select **Yes** or **No** in the message box depending upon whether you want to insert into your document both the progress tracking graph and the the scour and risk tables, only the progress tracking graph, or only the scour and risk tables (see figure below).

**NOTE:** If you chose **No** (i.e., to insert only the progress tracking graph or the tables), subsequent dialogue boxes will open to confirm your decision (see figures below).
The BridgeAMP.docx file will open.

**NOTE:** If the Word document does not appear to be open, look in the Windows toolbar, typically located at the bottom of your desktop, for the orange flashing Microsoft Word icon and select it (see figure below).

If you chose to insert the progress track graph, Excel will automatically insert the graph into the Microsoft Word template file, save the updated Word file, and direct you to the next step (i.e., inserting tables or BAMP Step 2).

If you chose to insert the tables, continue with the following steps; otherwise, proceed to step 5. If you are inserting the tables, Excel will now redirect you to the 5-ProgressTracking worksheet, and a message box will open (see figure below).

b. Search for “<#tablescourcritical>” in the Word document (see figure below).

c. Highlight “<#tablescourcritical>” within your document, and use Ctrl + V on your keyboard or select the Paste button from the Home ribbon (see figure below).
The **Scour Critical Bridges** table will be placed on the page, replacing the placeholder text (see figure below).

![Image of Excel and Word documents with tables](image)

d. Select **OK** in the message box in Excel (see figure in step 4a).

![Image of Excel message box](image)

⇒ A second message box will open prompting you to place the **Posted/Closed Bridges that are Critical Links** table (see figure below).

![Image of Excel message box](image)

e. Search for “&lt;#tablecriticallinks&gt;” in the Word document (see figure for step 4c for example).

f. Highlight “&lt;#tablescourcritical&gt;” within your document, and use **Ctrl + V** on your keyboard or select the **Paste** button from the **Home** ribbon (see figure for step 4c for example).

⇒ The **Posted/Closed Bridges that are Critical Links** table will be placed on the page, replacing the placeholder text.

g. Select **OK** in the message box in Excel (see figure in step 4a).
5. Select **BAMP Step 2: Export CSV for BAMP** (see figure below).

A .csv file will be exported to the same location as your bridge asset management plan, and a message box will open that prompts you to move on to step 3.

6. Select **Step 3: Open Appendixes to Print** (see figure below).

**NOTE:** The Appendix worksheets have formulas associated with each cell. These formulas parse the data from other worksheets into an appendix format. To help ensure that the formulas are not inadvertently altered, the appendix worksheets are protected sheets. The protection is set to allow you to format the cells with column and row lines. If, for any reason, you need to unprotect the sheet,
open the **Review** tab and select **Unprotect Sheet** from the **Changes** group; this will leave the worksheet’s formulas vulnerable to inadvertent changes that will render the Excel file useless for inserting data into the Word template.

⇒ The three **Appendix** worksheets will open.

a. Verify that the information transferred correctly into the appendix worksheets by visually assessing the worksheets.

**NOTE:** The three appendixes are indicated by Appendix A-1, Appendix A-2, and Appendix A-3 tabs. Selecting the tab makes that worksheet active (see figure below).

b. Select the tab for the first appendix that you wish to export for your bridge asset management plan (see figure above).

c. Select the A1 cell (this is a merged cell, so it will span several columns) in the selected appendix and, **while holding down the left mouse button**, drag your cursor to and inclusive of the last row of data and to and inclusive of the last column of data. Release the left mouse button.

OR: Select the A1 cell (this is a merged cell, so it will span several columns). While holding down the **Shift** key on your keyboard, use the **↓** and **→** arrow keys to select all of the cells to and inclusive of the last row and last column of data. Release the **Shift** key and the arrow keys.

d. Select **File** from the main menu.
e. Select **Export** from the **File** options.

![Image of Excel options menu]

⇒ The **Publish as PDF or XPS** window will open.

f. Select the desired file location for saving the Appendix export in the **Publish as PDF or XPS** window (see figure below); and, enter the desired file name in the **File Name** field.

**NOTE:** Leave the **Save as type** option set to **PDF ("pdf")** (see figure below).

**NOTE:** It is recommended to save the Appendix exports in the same location as the bridge asset management plan files.

g. Select the **Options...** button in the **Publish as PDF or XPS** window (see figure below).
The Options window will open (see figure below).

h. Select **Selection** in the *Publish what* group; leave the other options set to their defaults (see figure below).

i. Select the **OK** button in the *Options* window (see figure below).

j. Select the **Publish** button in the *Publish as PDF or XPS* window.

A .pdf file of your selected appendix will be generated and will be saved in the location that you specified.

k. Repeat steps 2 through 10 for the remaining two appendices.

**NOTE:** This procedure will generate three PDF files, one for each appendix. A similar export process can be done in Word to convert the Word portion of the bridge asset management plan into a PDF, as well. The full version of Adobe Acrobat or a free, open-source app can give you the capability to merge the four PDFs into a single PDF file.

7. Select **DONE** (see figure below).
**Note about BridgeAMP-Data.xlsm:** There are two additional worksheets built into the BridgeAMP-Data.xlsm file—the Agency-Data-Summary worksheet and the CalculationsSheet worksheet. These two worksheets are hidden and protected. They are embedded with formulas to parse the data from the Websource spreadsheet into a format that is usable by the asset management plan’s Word template. If it is necessary to access these worksheets, unhide and unprotect them; be aware that unhide and unprotecting them leaves them vulnerable to inadvertent changes that will render the Excel file useless for inserting data into the Word template.
Using the Word template

Opening the Word template
The bridge asset management plan data Excel template (i.e., BridgeAMP-Data.xlsm) file creates a copy of the originally-provided bridge asset management plan Word template (i.e., BridgeAMP_v2019.docx). This new file can be found in the same location on your computer where you saved the bridge asset management plan template files; it should be named BridgeAMP_v2019_agencyabbr.docx (where “agencyabbr” is the agency’s abbreviated name as entered in the questionnaire worksheet.

Opening the BridgeAMP_v2019_agencyabbr.docx file will immediately cause Microsoft Word to request the link between the Word template and the Excel spreadsheet data to be established; this occurs because the Word document is a mail-merge template and the document is searching for the data that should merge into the mail-merge fields.

It is safest to re-link the spreadsheet data using the Mailing tools in Word (procedure detailed below) rather than initiating the link in response to the warning dialogue box that appears upon opening the Word template. Re-linking the spreadsheet data in this way will allow you to specify exactly which file should be linked to your BridgeAMP_v2019_agencyabbr.docx template file. To re-link the spreadsheet data using the Mailing tools:

1. Open the BridgeAMP_v2019_agencyabbr.docx file in Microsoft Word.

   ➞ A Microsoft Word warning box will open.

   ![Microsoft Word Warning Box](image)

   Opening this document will run the following SQL command:

   SELECT * FROM "Agency.Data.Summary"  
   Data from your database will be placed in the document. Do you want to continue?

   ![Yes and No buttons](image)

2. Select No.

   ➞ The Word template will open. Proceed to the instructions for **Linking/re-linking the Excel spreadsheet data to the Word template**.

Linking/re-linking the Excel spreadsheet data to the Word template
To link or re-link the Excel spreadsheet data with the Word template and auto-fill corresponding mail-merge fields in the Word template:
1. With the BridgeAMP_v2019_agencyabbr.docx file open, select the **Mailings** ribbon (see figure below).

2. In the **Mailings** ribbon, select **Select Recipients** in the **Start Mail Merge** group; then, select **Use an Existing List** from the dropdown menu (see figure below).

   The **Select Data Source** dialogue box will open (see figure below).

3. Navigate to the save location for your exported .csv file using the **Select Data Source** window; then, select the .csv file and select **Open** (see figure above).

   The **File Conversion** window will appear (see figure below).
4. Select **Windows (Default)** in the **File Conversion – [yourcsv].csv** window, and select **OK** (see figure above).

⇒ The [yourcsv].csv file is now linked to the Word template and the data has been imported into the document.

5. In the **Mailings** ribbon, select **Preview Results** in the **Preview Results** group to preview the document with this auto-filled data.

⇒ Scroll through the document: Text fields previously enclosed with double-right and double-left carets (e.g.: «Agency_NameAbbreviation») should now be replaced with the appropriate data from the Excel spreadsheet.

**Inserting content into/ customizing the bridge asset management plan Word template**

**Inserting a logo**

There is one instance in the bridge asset management plan where you will need to insert an image—the title page should incorporate your agency’s logo. A **Picture** placeholder indicates where the logo should be inserted.

To insert a logo into the **Picture** placeholder:

1. Select the **Picture** placeholder where you plan to insert a logo or graphic (not a chart) (see figure below).
2. Select the icon in the center of the placeholder (see figure above).

⇒ The Insert Pictures dialog box will open (see figure below).

3. Select **Browse** > in the *From a file* option row in the Insert Pictures dialogue box (see figure below).

⇒ The Insert Picture window will open (see figure below).
4. Navigate to your desired image using the Insert Picture window; select the image and then select Insert (see figure above).

⇒ The Picture placeholder will be replaced with the selected logo or graphic.

Changing the color bar (Optional)

1. Select the color bar on the cover (see figure below).

2. Select Shape Fill in the Drawing Tools > Format ribbon Shape Styles group (see figure below).

3. Select a color from the dropdown menu or select More Fill Colors… for additional choices (see figure below).
Changing color of Cover and Heading 1 Styles (optional)

1. Select the expansion arrow for the *Home* ribbon *Styles* group (see figure below).

\[\text{The *Styles* pane will appear on the right side of the Microsoft Office window.}\]

2. Hover over the *Cover* or *Heading 1* style. DO NOT select the style otherwise you will apply it to the text where your in-text cursor is positioned.
A dropdown arrow will appear on the right side of the listed style.

3. Select the dropdown arrow.

4. Select **Modify…** from the dropdown list (see figure below).

![Modify Style window](image)

The **Modify Style** window will open (see figure below).

5. Select the dropdown arrow next to the color swatch (see figure below).

6. Select a color from the dropdown menu or select **More Fill Colors…** for additional choices (see figure below).
7. Select OK.

**Inserting charts (manual procedure)**
You may also choose to add Excel charts or graphs to your bridge asset management plan Word template (i.e., BridgeAMP_v2019_agencyabbr.docm). To insert Microsoft Excel charts/graphs into the Word document:

1. In the Excel workbook, select a chart/graph (see figure below).
2. In the Excel workbook’s Home tab, select **Copy** from the Clipboard group to copy the chart/graph to the Windows clipboard.

   **OR:** Right-click on the chart/graph; select **Copy** from the dropdown menu.

   **OR:** Use the **Ctrl + C** keyboard shortcut.

3. In your compliance plan Word template (i.e., complianceplan_v2019.docm), place cursor at the position in the document where the chart or graph should be inserted.

   **NOTE:** If your compliance plan Word template was not open before you started this procedure, you may open it now.

4. In Word’s Home tab, select **Paste** from the Clipboard group to paste the chart/graph that was copied to the Windows clipboard.

   **OR:** Right-click where your cursor is positioned, and select **Paste** from the dropdown menu.

   **OR:** Use the **Ctrl+V** keyboard shortcut.

---

**Inserting images**
Maps and other images will help communicate your inventory of assets and your asset management goals.

**NOTE:** The procedure for creating a map of bridge assets in Roadsoft, exporting it as a PDF, and saving the PDF as an image file is detailed below.

To insert an image into the Word template:

1. Place cursor where you desire to insert an image.
2. Select **Pictures** in the *Insert* ribbon *Illustrations* group.

![Insert Picture ribbon](image1.png)

- The *Insert Picture* window will open (see figure below).

3. Navigate to your desired image using the *Insert Picture* window; select the image and then select **Insert** (see figure below).

![Insert Picture window](image2.png)

- The picture will insert into the Word template.

4. Adjust by selecting the image and using **Wrap Text** option in the *Picture Tools > Format* ribbon (see figure below).

![Wrap Text option](image3.png)
Creating a map of bridge assets in Roadsoft

The bridge asset management plan should contain a map of your county’s bridges and their condition assessments. In Roadsoft:

1. Select **Bridges** from the layer window on the left side of the screen (see figure below).

   ✗ A prompt will open if the bridge data needs to be imported; the data will important. To re-import bridge data, right-click on the **Bridges** category and select **Re-Import Bridge Data**.

2. Select the **Legend Builder** icon.

   ✗ The **Legend Builder** window will open.

3. Select **Good/Fair/Poor Rating** from the dropdown list in the **Legend Builder** window (see figure below).

4. Select the **Good**, **Fair**, and **Poor** values so that they are highlighted blue (see figure below).
5. Select **Add Selected Unique Value(s)** (see figure below).

![Legend Builder](image)

6. Change the color of the bridges based on their condition under **Item Properties**: (see figure below).

![Item Properties](image)

7. Select **Apply**.

⇒ The bridges on the map will turn colors according to their respective condition.
8. Add a filter to display bridges based on ownership.

   a. Select **Filter Builder** from the Filter tab located above the map.

   b. Search for “owner” in the search bar of the Filter Builder window (see figure below).

   c. Add the desired value option.

   d. Select **Apply as Filter**.

   e. Check to make sure only the bridges owned by the value chosen are displayed on the map.
Completing the Word template

Working with list items
Some sections of the template enable you or require you to create lists:

- OBJECTIVES (Note: This section’s list is not necessary to extend, but may be extended if desired.)

NOTE: As long as the list always has one placeholder list item (which appears boxed and, in the Bridge Inspection Report sections, contains the [red text field] placeholders) in it, selecting the + button will generate a new list item template. You will want to generate additional list items before replacing red text fields; see the Working with red text fields section below.

To generate additional items in a required list:

1. Find a list item.
2. Place cursor anywhere inside in the list item.
3. Select the + button on the lower right corner of the list item before filling in any of the text fields.
A new, blank list item will be generated below the previous list item and will contain the text fields that need to be completed.

4. Repeat this process as necessary to obtain the appropriate number of list items.

To delete items in a required list:

1. Select the list item with the right mouse button.

⇒ A drop-down menu will appear (see figure below).

2. Select Delete Item from the drop-down menu (see figure below).

Working with red text fields

[Red text fields] are placeholders for user-entered data. They can be found in the following sections:

- FIVE-YEAR ANNUAL COST PROJECTION
- «AGENCY_FULL_NAME» [YYYY] BRIDGE INSPECTION REPORT SUMMARY OF ADDITIONAL INSPECTION RECOMMENDATIONS
• «AGENCY_FULL_NAME» [YYYY] BRIDGE INSPECTION REPORT EXECUTIVE SUMMARY

To replace red text field placeholders—Each of these placeholders has a different prompt depending on the type of information to be inputted.

1. Find and highlight a red text field by either:
   a. placing your cursor at the beginning of the Word document and then selecting **F11**.
   OR
   b. directly selecting an instance and highlighting the text field including the black brackets around it.

   ⇒ The red text field will be highlighted in a dark grey color.

2. Replace the text field by typing the information for which the red text is prompting.
Generating annual cost projection/gap analysis data from the budget template

The BridgeAM-Budget.xlsx Excel file is a comprehensive budgeting tool that allows you to plan your bridge maintenance budget allocations by organizing various types of bridge maintenance projects and their associated costs. It also helps to identify gaps in funding.

Welcome Worksheet

**NOTE:** When you open the BridgeAM-Budget.xlsx file, you will be greeted with a welcome message in the Welcome worksheet. If you see the security warning, refer to *Using the XLSM File for the First Time* in this Instruction Guide.

1. In cell A5, enter the first year of the five-year range that your asset management plan will address (see figure below).
The four subsequent years will automatically populate (see below).

2. Enter the region and your TSC using the dropdown lists (see figure below).
3. **OPTIONAL**: Enter your priority metrics (see figure below)

**NOTE**: The total will display at the bottom to ensure the metric equals 100%.
4. Select **Okay**.

![Image of Excel sheet with instructions to select Okay]

⇒ You will automatically proceed to the MiBRIDGE data worksheet and the *Please select your custom MiBridge data file* dialogue box will open (see figure below).

5. Select **[Your County].csv** file from the location that it is stored on your computer (see figure below).

6. Select **Open**.

![Image of Excel sheet with instructions to select Open]

⇒ Excel will automatically import your MiBRIDGE data, and you will be directed to the Summary worksheet.
7. Select **Save** to save your work before continuing (see figure below).

**NOTE:** It is recommended that you **save your work** at this point in order to avoiding having to re-import your MiBRIDGE data.

**NOTE:** If necessary, you can manually import the data by un-hiding the MiBRIDGE worksheet, select the E2 cell, and following the steps at the end of the BridgeAMP-Data.xlsm’s 1-MiBRIDGEReport procedure (see figure below). **Remember to hide the MiBRIDGE worksheet in your BridgeAM-Budget.xlsm before continuing.**

**Summary Worksheet**

The initial worksheet is the blank **Summary** sheet. This sheet will summarize worksheet names, project types, project dates, bridge identification numbers, and total project costs as you add data to the workbook (see figure below).
Adding Bridge Cost Estimates

**NOTE:** The *Bridge Cost Estimate Worksheet* itemizes key cost information for each of your bridge projects. The information will be added to the summary worksheet for transformation into a cost projection and gap analysis table that can be easily inserted into the asset management plan.

**NOTE:** All dark green and dark blue fields in the main header section of the *Bridge Cost Estimate Worksheet* must be completed. Dark green fields to the right of the main header section (i.e., financial information and priority metric scores) are optional.

1. Create a new *Bridge Cost Estimate Worksheet* by selecting **Add Cost Estimate Worksheet** on the *Summary* worksheet (see figure below).

⇒ The new *Bridge Cost Estimate Worksheet*, by default labelled as “CPM-RR (2)”, will become the active worksheet.

**NOTE:** Information from the Welcome worksheet will automatically transfer to the *Cost Estimate* worksheet’s *REGION* and *TSC* fields. The *FISCAL YEAR* dropdown list options are also set based on your input on the Welcome worksheet. (see figure below).
2. Fill in the mandatory fields.

**NOTE:** The STRUCTURE ID, PRIMARY WORK ACTIVITY, and FISCAL YEAR fields determine the UNIQUE ID field, which will become the name assigned to this specific worksheet. The other fields are present for bookkeeping and have no effect on any other part of the workbook.

a. For the STRUCTURE ID field, select a bridge structure number from the dropdown list (see figure below).

⇒ Information about the structure will automatically populate many of the light blue fields after the Structure ID is chosen.

b. For the PRIMARY WORK ACTIVITY field:

i. Begin by selecting a WORK ACTIVITY from the drop-down list associated with the WORK ACTIVITY (select first) (see figure below).

⇒ The dropdown list associated with PRIMARY WORK ACTIVITY is populated based on your selection for WORK ACTIVITY (select first).

ii. Select the PRIMARY WORK ACTIVITY from the dropdown list associated with the PRIMARY WORK ACTIVITY (see figure below).

c. For the FISCAL YEAR field, select a year from the dropdown list (see figure below).
3. Fill in the optional fields.

4. Enter quantity in the Quantity column for each item needed for the project in the New Bridge, New Superstructure, Widening, New Deck, Demolition, Deck Repair/Treatment, Superstructure Repair, Substructure Repair, Miscellaneous, Road Work, and Traffic Control sections; if necessary, update the unit cost (note that you will need to unprotect the worksheet to update unit costs) (see figures above and below).

**NOTE:** The Total cost will automatically update (see figure below).

**NOTE:** Some line items are calculated as lump sums (i.e., “LSUM”). They will have blank or $0 Total cost unless both Quantity and Unit Cost columns are completed (figure below).
**NOTE:** Any amounts entered into the *Quantity* column will, by default, only display up to one decimal point. This setting can be changed with the *Increase Decimal* and *Decrease Decimal* buttons in the *Number* group of the *Home* ribbon (see figure below).

**NOTE:** Any numbers greater than six digits entered in the *Quantity* column will appear as hash tags. Increase the column width to view the entire number (see figure below).

5. **OPTIONAL:** Enter unique work items in the *Other* line item, inputting *Quantity*, *Unit*, and *Unit Cost* accordingly (see figure below).

**NOTE:** Do not attempt to create new work items by adding or deleting rows from the worksheet. All cells need to maintain their exact cell references for the worksheet to function properly. If there is a need for additional other items, input line item information over an unused work item.
6. Adjust the percentage as necessary for Contingency, Mobilization, and Inflation sections (see figure below).

7. When satisfied with worksheet data inputs, select the Add Data to Summary Sheet button.

The Summary worksheet will become the active worksheet; the project worksheet will be assigned its unique worksheet name (seen on the worksheets tab and listed in Worksheet Name column on the Summary worksheet); and the project summary for the completed worksheet will be added to the list on the Summary worksheet. Select the worksheet tab (at the bottom of the Excel window) that corresponds to a specific project’s Worksheet Name to re-access project details (see figure below).

**NOTE:** Any changes to the budgetary information in an already-added project worksheet will automatically update the information in the Summary worksheet.
To rename a *Bridge Cost Estimate Worksheet* after it has been added to the *Summary* worksheet:

1. Select the worksheet tab (at the bottom of the Excel window) that corresponds to a specific project’s *Worksheet Name* listed on the *Summary* worksheet in order to re-access project details.

   ⇒ The project’s worksheet will become the active worksheet.

2. Adjust the *STRUCTURE ID*, *PRIMARY WORK ACTIVITY*, and/or *FISCAL YEAR* field(s) as necessary (see figure below).

   **NOTE:** Verify the revised name in the *UNIQUE ID* field (see figure below).

3. Select the *Rename Worksheet* button (see figure below).
The new worksheet name (i.e., UNIQUE ID) will be applied to the worksheet’s tab and will be updated in the Summary worksheet’s Worksheet Name column.

4. Select the Summary worksheet tab at the bottom of the Excel window to return to the Summary worksheet.
Creating a Cost Projection/Gap Analysis Table

The cost projection/gap analysis table will present your data in a format that can be more easily transferred into the BridgeAMP.docx Word document’s Prioritization, Programmed/Funded Projects, and Planned Projects section’s Planned Projects subsection.

**NOTE:** The CPTable worksheet is a printer-friendly layout summarizing your cost estimates. To create or update the CPTable worksheet, any existing CPTable worksheet must be deleted first. To delete a CPTable, right-click on the CPTable worksheet tab and select **Delete** from the drop-down menu (see figure below).

1. Ensure that the *Summary* worksheet is the active worksheet.
2. Select the **Create Project Cost Projection/Gap Table** button (see figure below).

![Excel Worksheet](image1.png)

The **CPTable** worksheet will automatically generate, and cells A1 through the last column and last row will automatically be selected and copied to the Windows clipboard; a message box will open with directions for the next step (see figure below).

**NOTE:** The **CPTable** worksheet orders all projects, first, by project type (in this order: Reconstruction, Replacement, Rehabilitation, Capital Preventive Maintenance, Scheduled Maintenance, and Other) and, then, by date/gap.

![Message Box](image2.png)

3. While leaving BridgeAM-Budget.xlsm open, open the BridgeAMP.docx Word document.

4. Navigate to the “Planned Projects” section’s **Table 4: Cost Projection Table** (see figure below).
5. Select the [Copy and paste your Cost Projection table from your budget spreadsheet here] placeholder (see figure below).

6. Paste your cost projection/gap analysis table (see figure below):
   a. Right-click on your selection and select Paste from the dropdown menu.

   OR:

   Use Ctrl + V on your keyboard.
7. Format table as desired.

8. Return to Excel, complete any remaining work, and save and close the workbook.
Creating Financial Resources Content

A bridge asset management plan should overview anticipated revenues and expenses that have the potential to affect the management of bridge assets. In the BridgeAMP.docx template, anticipated revenues and expenses are detailed in the 2. Financial Resources section (see figure below). This content can be generated in the BridgeAMP-Data.xlsm file, the BridgeAM-Budget.xlsm file, or in the BridgeAMP.docx file (by deleting the mail merge tags and free writing the content).

Developing Financial Resources Content in the Bridge AMP Data Workbook

To develop the financial resources content in the BridgeAMP-Data.xlsm file:

1. Answer 2-Questionnaire worksheet questions in the Identify Funding Sources section (rows 52 to 73) (see figure below).
NOTE: The 2-Questionnaire worksheet Identify Funding Sources section requires you to select funding sources and to list bridge structure numbers, funding years, and/or application years. This information can be tagged with each Bridge Cost Estimate Worksheet in the BridgeAM-Budget.xlsm workbook, and the sentences can be automatically generated from that tagging (see directions below). A highlighted yellow cell in row 52 of the BridgeAMP-Data.xlsm’s 2-Questionnaire worksheet will remind you of this option (see figure above).

Developing Financial Resources Content in the Bridge AMP Data Workbook
To develop the financial resources content in the BridgeAM-Budget.xlsm file:

1. Fill in optional fields on each Bridge Cost Estimate Worksheet (see figure below).

2. Select the Summary worksheet (see figure below).

3. Select Create Funding Sources Sentences on the Summary worksheet (see figure below).
The Financial Resources sentences will automatically generate, and the *Identify your bridge AMP data*.csv file dialogue box will open.

4. From within the *Identify your bridge AMP data*.csv file dialogue box, navigate to and select your your bridge asset management plan .csv file that you created from the BridgeAMP-Data.xlsm workbook.

5. Select **OK**.

The Financial Resources sentences will be placed into your bridge asset management plan .csv file.
Reviewing the template for errors and finalizing

Once the bridge asset management plan .csv file has been created, it will be automatically linked to the BridgeAMP_v2019_agencyabbr.docx template. The template should then be checked for unfilled text fields that should have been replaced with required information. This check should be done to ensure that no text field is overlooked and forgotten. To check the template:

1. In the Mailings ribbon, select **Check for Errors** in the Preview Results group.

   Word will open the **Checking and Reporting Errors** dialog box.

2. Select **Complete the merge, pausing to report each error as it occurs**, and select **OK**.

   Word will prompt you to complete any unfilled text fields using a Microsoft Word information prompt window, such as the one below.

3. Enter in the requested information in the Microsoft Word information prompt window, and select **OK**.

4. Repeat step 3 until there are no more Microsoft Word information prompt windows remaining.

   Microsoft Word will generate a new file, named **Letters 01.docx**, of your final asset management plan.

5. Save Letters 01.docx with a unique name—such as BridgeAMP-2020_agencyabbr.docx—in the desired location on your computer (see recommended save location information on page 1).
Updating Table of Contents, Table of Figures, and/or Table of Tables

1. Update Table of Contents

   a. Select the Contents field.

      **NOTE:** The Contents may also be titled Table of Contents.

      → The Contents will highlight in grey and the Contents menu bar will appear (see figure below).

      ![Contents Menu Bar](image-url)

   b. Select **Update Table** in the Contents menu bar (see figure above).

      OR: Right-click in the Contents field, and select **Update Field** from the dropdown menu (see figure below).
A dialogue box will open prompting you to select an update option (see figure below).

c. Select **Update entire table**, and then select **OK** (see figure above).

**NOTE:** If you select **Update page numbers only**, Word may not update the *Table of Contents* to reflect every added or removed section but only the new page numbers corresponding to existing sections. Selecting **Update entire table** will update all sections and page numbers.

The *Table of Contents* will update to reflect the changes you have made to the document.

**NOTE:** If you make further changes to the Word document that involves adding or removing sections or changing page numbers, you will need to update the *Table of Contents* again to reflect these changes. The *Table of Contents* does not update automatically.
2. Update Table of Figures
   
   a. Select the **Table of Figures** field.
   
   ⇒ The Table of Figures field will highlight in grey (see figure below).

   ![Table of Figures Highlighted](Image)

   b. Right-click in the **Table of Figures** field, and select **Update Field** from the dropdown menu (see figure below).

   ![Update Field Dropdown](Image)
A dialogue box will open (see figure below).

![Update Table of Figures dialog box](image)

Select Update entire table, then select OK.

**NOTE:** If you select Update page numbers only, Word may not update the Table of Figures to reflect every added or removed figure but only the new page numbers corresponding to existing figures. Selecting Update entire table will update all figures and page numbers.

The Table of Figures will update to reflect the changes you have made to the document.

**NOTE:** If you make further changes to the Word document that involves adding or removing figures or changing page numbers, you will need to update the Table of Figures again to reflect these changes. The Table of Figures does not update automatically.

3. Update Table of Tables

**NOTE:** A Table of Tables will automatically merge into a preceding table and be deleted. Therefore, a Table of Tables should be created at the end of the entire document, copied, and pasted after the Table of Figures.

a. Delete the Table of Tables in the current document, leaving the heading in place.

b. Place your cursor at the very end of the document.

c. Select Insert Table of Figures in the References ribbon Captions group.
The Table of Figures window will open (see figure below).

d. Select Table from the Caption label drop-down menu (see figure above).

e. Select OK.

f. Highlight the inserted Table of Tables.

g. Drag and drop your selection below the Table of Tables heading (see figure below).
Inserting Appendixes
To create a single bridge asset management plan document, save the bridge asset management plan Word template and any other associated files as PDFs. Note that you will already have three appendixes created during the Build a Bridge Asset Management Plan step and saved as PDFs. Then, using a PDF editing software program, merge the PDFs into a single PDF.

To save a Word document as a PDF:

1. Select File in the ribbon menu.

![Screenshot of Microsoft Word ribbon menu](image1)

2. Select Save as Adobe PDF in the File sidebar menu (see figure below).

![Screenshot of Info window](image2)

OR: Select Print in the File sidebar menu (see figure above).

⇒ The Windows Print window will open (see figure below).
a. Select **Microsoft Print to PDF** from the *Print* window (see figure above).

b. Select **Print** (see figure above).

⇒ The *Save Print Output As* window will open.

c. Navigate in the *Save Print Output As* window to the desired folder containing compliance plan materials, enter a descriptive file name in the *File name* input box (e.g., *complianceplan_2019* or *complianceplan-appendix1_2019*), and select **Save**.

OR: In the *Home* ribbon, select **Create and Share Adobe PDF** in the *Adobe Acrobat* group (see figure below).

3. Once all necessary files have been saved as a PDF, proceed with using a PDF editor to compile all necessary PDFs into a single PDF.
APPENDIX

Alternate Directions for: 2-MiBRIDGEreport Worksheet

The dataset provided as part of the workshop is a customized MiBRIDGE download; the ability to customize a MiBRIDGE download on the user end is an unavailable feature. Nonetheless, if you have a need to update information in your asset management plan, you can pull some of that information from a standard MiBRIDGE download. The instructions below will guide you through downloading your bridge data from MiBRIDGE and inserting it into your BridgeAMP-Data.xlsm file.

**NOTE:** The 2-MiBRIDGEreport worksheet requires access to MiBRIDGE (login requires a username and password).

1. Copy data from your agency’s MiBRIDGE download file.
   a. Open a web browser (e.g., Internet Explorer, Mozilla Firefox, Microsoft Edge).
   b. Navigate to [https://www.michigan.gov/mdot/0,4616,7-151-9625_70811_59528---00.html](https://www.michigan.gov/mdot/0,4616,7-151-9625_70811_59528---00.html) and log on to MiBRIDGE.
   c. Enter your User Id and Password in the appropriate fields, and select Sign In.
   d. Select Export Data to Excel, located beneath the Structure Inventory Summary embedded spreadsheet (at the bottom of the webpage).
   
   ![Export Data to Excel](image)

   e. Follow the browser prompts—selecting Save as... to specify the location on your computer where the file will save—to save the generated file to your computer.

   **NOTE:** If you are using Microsoft Internet Explorer or Microsoft Edge, the generated file will save as a .xls file. This can be opened by double clicking on the file itself or it can be opened in Excel. If you are using Mozilla Firefox, the Opening exportStructureConditionDashboard.jsp dialogue box will open; select either Open with Microsoft Excel selected from the dropdown menu or Save File and choose a desired save location. If you are using Google Chrome, the browser will save exportStructureConditionDashboard.jsp to the default download folder, which is the Downloads folder on your PC.
f. To open `exportStructureConditionDashboard.xls`:
   i. Navigate to the saved location on your computer.
   ii. Double-click on the downloaded file.

OR: To open `exportStructureConditionDashboard.xls` or `exportStructureConditionDashboard.jsp`:

   i. Open Microsoft Excel.
   ii. Select **Open Other Workbooks** from the Excel start screen.

   ![Excel Start Screen](image)

OR: When a blank workbook is open, select **File** from the main menu.

   ![Excel File Menu](image)

   i. Select open from the file options menu, and then select **Browse** to browse for the .xls or .jsp file.
   ii. Navigate to the desired file in the **Open** window, select the file, and then select the **Open** button.
**IMPORTANT:** A Microsoft Excel warning dialogue box may open when you attempt to open either exportStructureConditionDashboard.xls or exportStructureConditionDashboard.jsp in Excel. This file is safe to open: select Yes.

---

g. Highlight the cells you wish to transfer—excluding the headings—in the exportStructureConditionDashboard.xls or exportStructureConditionDashboard.jsp file.

**NOTE:** The data most likely will begin in cell A8. You will need to compare header columns between the template and the MiBRIDGE download as there are discrepancies between the order in which they appear. In the event of a discrepancy, highlight from the first column, first row of data through to the last column that matches up with the template file, last row of data. Proceed to step h and step 2 for the selected data. Repeat 1g-h and step 2 until all desired data has been transferred into the BridgeAMP-Data.xlsm file.

h. Copy data from the exportStructureConditionDashboard.xls (or.jsp) worksheet:
   In the *Home* ribbon, select **Copy** from the *Clipboard* group.
   OR: Right-click on the highlighted cells; select **Copy** from the dropdown menu.
   OR: Use the **Ctrl + C** keyboard shortcut.

2. Paste in cells the appropriate cells—based on the data that you selected in step 1g—the data that you copied from your agency’s MiBRIDGE download file.

**NOTE:** The BridgeAMP-Data.xlsm file should still be open. If it is not already open, locate the file and reopen it.

   a. Return to or open the BridgeAMP-Data.xlsm file.
b. Select the 2-MiBRIDGEreport tab to access the 2-MiBRIDGEreport worksheet.

c. Set cursor in the appropriate cell (corresponding data column and row 2) based on the information copied in step 1g.

d. Paste data into the 2-MiBRIDGEreport worksheet:
   Select Paste from the Clipboard group.
   OR: Right-click in the appropriate cell; select Paste from the dropdown menu.
   OR: Use the Ctrl + V keyboard shortcut.

3. Remember to select Save in order to save your work before continuing.